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About This Guide

This book describes the new and updated features and options in
Wizcon 7.6. While many of the features are new, such as Cluster Editing,
some of them are based on original Wizcon options. Therefore, it may be
helpful to have a copy of the Wizcon User Guide version 7.5 at hand for
further reference.

This guide contains the following chapters:

Chapter 1, Internet Enhancements, describes the newly supported
features for remote users.

Chapter 2, Image Enhancements, describes the new features and options
Wizcon provides when working with Images.

Chapter 3, System Enhancements, describes how to ensure that only
authorized users access specific parts of the Wizcon system. It also
describes how to log operator actions (tag values) to a database file.

Chapter 4, File Conversion Enhancements, describes how to
export/import alarm, tag and VPI block definitions to CSV file format. It
also describes the external conversion utility.

Chapter 5, Alarm/Tag Enhancements, describes newly supported features
in tags and alarms.
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Chapter 1  
Internet Enhancements

About this chapter:

This chapter describes the new features and additions made to Wizcon to
benefit Internet (remote) users, as follows:

Remote User Login, page 1-2, describes the new user login option for
users accessing Wizcon via the Internet.

Popup Events Summaries, page 1-7, describes how to configure and setup
Popup Events Summaries for remote display.

Viewing Alarms in History Mode, page 1-11, describes how to view a list
of historical alarms in an Events Summary Viewer. This section also
describes how to configure and generate an alarm report.

Modifying Trends, page 1-15, describes how to modify trends online. This
includes modifying the list of available tags, and the time and date filters
used for displaying data.

Displaying a Grid in Trends, page 1-22, describes how to display a grid in
a Trend.

Miscellaneous, page 1-28, describes additional Wizcon options that are
now available for Internet users.
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Remote User Login

Wizcon now supports the login of remote users through a browser so they
can access Wizcon options in much the same way as local Wizcon users.

A remote user can access all the same group-assigned options as available
when logged in as a local user. The definitions behind these options are
stored on the server, enabling remote users to access their application from
any computer.

This Wizcon login option has the added flexibility of being enabled or
disabled. Users can then:

! Login using their user name and password and access their
group-assigned options, or

! Login using a default user name and password and access the options
specified for default users.

Login/Logout Quick Access Bar

Wizcon provides the Login/Logout Quick Access bar to enable you to
quickly login and out of the Wizcon system. This Quick Access bar appears
when the browser is opened.

Wizcon enables you to replace the Login/Logout Quick Access bar, and
design your own login/logout interface using HTML script. Wizcon’s
remote user options will still run in the background.
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! To login:

1. Start Wizcon and access your application. The browser is launched.

 

 A typical browser will display the Wizcon icon which you can click to
begin login. You can also click Login on the Login/Logout Quick
Access bar displayed in the top left corner of the window. The Login
user window is displayed:

 

2. Enter your user name in the Name field.
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3. Enter your password in the Password field.

4. Click OK. Login is initiated and your application is accessed.

! To logout:

Click the Logout button on the Login/Logout Quick Access bar, or close
your browser.

Specifying Remote User Login Parameters

You can specify the following remote user login parameters:

! Enable only authorized users remote access.

! Enable all users remote access by enabling them to login in as a default
user. This way any user can login and access the options specified for
default users.
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! To specify remote user login parameters:

1. In the All Containers list, right-click on HTML and select Properties
from the popup menu. The HTML Properties dialog is displayed.

2. Select the Users tab. The following dialog is displayed:

 

 You can select all or no options.

3. Select Enable Login Quick Access Bar in browser so that a user must
enter a user name and password to login.

4. Select Automatically login with default user to enable any user to
login with a default user name and password. This means that any user
can access the application and use the options that are assigned to
default users.

5. Click OK to save your options and close the dialog.
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Customizing the Login/Logout Procedure

Wizcon enables experienced HTML users to customize the login/logout
procedure on their computers by creating buttons in HTML and attaching
HTML script, as follows:

HTML Script To do

scriptLoginUser () Display the Wizcon Login user
dialog to login to the system.

scriptLogoutUser() Logout.

scriptGetCurrentUserName() Display the current logged in
user.

After customizing the login/logout procedure, deselect the remote user
login parameters described on the previous page, so that the Login/Logout
Quick Access bar is replaced by your own login interface.

Note: Wizcon’s remote system mechanisms will continue to run in the
background.
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Popup Events Summaries

The Wizcon for Internet system now supports Popup Events Summaries to
enable realtime monitoring of alarms. The section describes:

! Viewing Popup Events Summaries in browsers, as described below.

! Designing Popup Events Summaries, as described on page 1-9.

! Enabling Popup Events Summary display in browsers, as described on
page 1-10.

Viewing a Popup Events Summary in a Browser

Following is an example of a Popup Events Summary that appears in a
browser:
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The Popup Events Summary displays the following alarm information at the
top of its window:

Alarms Specifies the number of alarms that appear in the Popup Events
Summary.

Date Specifies the date that appears in the server at the time the
Popup Events Summary is activated.

Time Specifies the time that appears in the server when the Popup
Events Summary is activated.

Alarms are displayed in the Popup Events Summary according to the filter
conditions specified when the Popup Events Summary is defined. The
example on the previous page displays the following filters:

Start time Displays the time the alarm was triggered.

Zone Displays the zone defined for the alarm.

Text Displays the text defined for the alarm.

The following options are available at the bottom of the Popup Event
Summary:

Clear Clears the selected alarm from the Popup Events Summary.

Clear All Clears all the alarms from the Popup Events Summary.

Relax Clears the Popup Events Summary from the screen for a
pre-defined amount of time.
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Designing Popup Events Summaries

Designing a Popup Events Summary that is displayed in a browser is
identical to designing a standard Popup Events Summary.

Designing Popup Events Summaries is described in Chapter 9, Events
Summaries in the Wizcon User's Guide.

Popup Display Options

Wizcon supports the following display options. These options are defined
by selecting Popup Settings from the Design menu of the Wizcon
Application Studio, and include:

Filter Assigns values to each of the alarm classifications so that the
Popup Events Summary will display only the alarms that meet
these specifications.

Sort Specifies the categories and their order, according to which
the alarms will be sorted in the Popup Events Summary.

Display Specifies which alarm components are displayed in the Popup
Events Summary.

Color Assigns alarm text and background colors according to their
severity level or zone.

Options Specifies Popup Events Summary window parameters. (Title
bar and List Length are not available.)

Important: Wizcon for Internet supports all available popup options except
for Buzz.
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Enabling Popup Events Summary Display in Browsers

You can specify whether or not Popup Event Summary display is enabled in
a browser. You can also assign group authorization so that the Popup
Events Summary is displayed only in the browser of authorized users.

! To enable display in browsers:

1. In the All Containers section of the Wizcon Application Studio,
right-click HTML and select Properties from the popup menu. The
HTML Properties dialog is displayed.

2. Select the Popup tab to display the following:

 

3. Make sure that Enable Popup window in browser is selected so that
the Popup Events Summary is displayed in the browser.

4. Click the Groups button to display the standard Wizcon Groups dialog
in which you can assign group authorization for Popup Events
Summary display.
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Viewing Alarms in History Mode

Wizcon now provides two modes for alarm display in an Events Summary
Viewer. In addition to the online mode, which features realtime monitoring
of alarms, Wizcon provides a history mode that displays a report of
historical alarms. This shows a list of alarm activities for a specified period
of time. For example, alarm information one week ago from the current
date.

Wizcon enables you to define filters for the Events Summary Viewer to
specify what type of alarm information is displayed. For example, you can
define a filter that will display only the start time of the alarms that were
activated one week ago from the current date.

Online Mode

The following Events Summary Viewer is displayed in online mode.
Clicking History, on the left of the menu bar, displays the Events Summary
Viewer in history mode. All other options are described in more detail in
Chapter 10, Creating Events Summary Profiles in the Wizcon User’s
Guide.



1-12  Wizcon 7.6 What’s New Guide

History Mode

The following Events Summary Viewer is displayed in history mode.

The following options are available:

Online Displays the Events Summary Viewer in online mode.

Columns Specifies filters for the Events Summary Viewer that determine
what type of alarm information it displays. This option is also
available in online mode and is described in detail in
Chapter 10, Creating Events Summary Profiles in the Wizcon
User's Guide.

Report Configures historical alarm reports, as described on the
following page.

Note: Any changes you make to the Events Summary Viewer are available
until you refresh. The next time you login, the default Events Summary
Viewer parameters are displayed.
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Configuring Alarm Reports

Wizcon provides the following filters to configure the information that is
displayed in an alarm report.

! The range of date and time an alarm was activated.

! The range of date and time an alarm was acknowledged.

! The range of date and time an alarm ended.

! To configure an alarm report:

1. Select History in the Events Summary Viewer. The Events Summary
Viewer is displayed in History mode.

2. Select Report. The Alarm Report dialog is displayed:

This dialog is similar to the standard Alarm Report Definition dialog.
For more information about specifying the filters in this dialog, refer to
the section on Configuring Alarm Reports in Chapter 9, Events
Summaries in the Wizcon User’s Guide.

3. Click OK when you have specified the required filters. The Alarm
Report dialog closes and a progress dialog is displayed while Wizcon
Connects to the server.
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A system file with an adb extension is created in the Docs/History
folder of your application.

 

4. (Optional) You can stop Wizcon from transferring the history
information to this file at any time by pressing Cancel. Wizcon then
displays a message in the Events Summary Viewer, notifying that the
history reading has been cancelled.

 When the query is complete, Wizcon reads the history file prior to
displaying the alarm report. A progress dialog appears displaying how
much of the file has been read

 

5. (Optional) You can click Cancel at any time to stop Wizcon from
reading the history prior to displaying the report in your browser. This
is useful if the report is larger than you expected.

When the history reading is complete, the report is displayed in your
browser.
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Modifying Trends

Trends are used to compare device functionality and correlate actions and
responses. Their data can be displayed in one of two modes: online and
history.

Trends are described in more detail in Chapter 14, Creating Trend Viewers
in the Wizcon User’s Guide.

The Trend Viewer has been modified to include a menu bar in its top left
corner, as shown below:
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Wizcon now enables you to do the following in Trends:

! Represent a tag in a Trend with a bar line, as described on page 1-16.

! Modify the tags that are specified in the Trend, as described on
page 1-18.

! Modify the start time of data display, as described on page 1-20.

! Print the information displayed in the Trend Viewer, as described on
page 1-21.

! Display a grid in a trend, as described on page 1-22.

Defining a Bar Line

In addition to the two currently supported lines: a line with markers and a
curved line, Wizcon now offers a bar line to represent tags in Trends. Line
types are specified when adding tags to Trends.



Internet Enhancements  1-17

! To define a bar line:

1. In the All Containers section of the Wizcon Application Studio,
right-click Trend Profiles and select New Profile from the popup
menu. The Trend Profile dialog is displayed.

2. Click the Add button. The Add the new tag dialog is displayed:

 

3. Click the Tag name field and select a tag from the list of available tags.

4. Click the Line type field and select Bar. The tag is now represented in
the Trend with a bar line.

5. Click OK to close the dialog.
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Modifying the Tag List

Wizcon enables you to add tags, modify current tag specifications and
remove the tags that are displayed in the Trend Viewer. These changes are
made online and are in effect until you refresh the browser. The Trend
Viewer is then displayed according to its default settings.

! To add a tag:

1. Select Edit Tags from the Setup menu of the Trend Viewer. The Tag
definition dialog is displayed:
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2. Click Add. The Tag definition dialog is displayed in which you can add
a tag. This tag is similar to the standard Add the new tag dialog used
during Trend Viewer definition.

 

3. Click OK to close the dialog and save your changes.

! To modify current tag specifications:

1. Select Edit Tags from the Setup menu. The Tag definition dialog is
displayed.

2. Select the tag you want to modify and click Edit. The Tag definition
dialog is displayed in which you can change the current tag
specifications.

3. Click OK to save your changes and close the dialog.

! To remove a tag:

1. Select Edit Tags from the Setup menu. The Tag definition dialog is
displayed.

2. Select the tag you want to remove and click Remove. The tag is
removed from the Tag list.
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Modifying the Start Time of Data Display

Wizcon enables you to modify the start time of the data displayed in the
Trend Viewer.

Your changes are in effect until you refresh the browser. The Trend Viewer
is then displayed according to its default settings.

! To modify the time and date:

Select Time from the Setup menu. The Time set definition dialog is
displayed in which you can modify the time and date.

The fields in this dialog contain date and time information that can be
accessed by using the up and down arrows. You can also use the left and
right arrows in the Start on field to navigate between the day, month and
year options within the field.
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This dialog is similar to the Time tab of the Time Set Definition dialog used
to specify the date and time during Trend Viewer definition. Its options are
described in detail in Chapter 14, Creating Trend Viewers in the Wizcon
User’s Guide.

Printing Trend Viewers

Wizcon now enables you to print trend viewers as they appear in the
browser.

! To print:

Select Print from the Options menu of the Trend Viewer.
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Displaying a Grid in Trends

Wizcon now enables you to display a grid in a Trend Viewer. This is useful
for reading the Trend activities quickly and accurately.

The Trend Viewer contains its own default grid properties which you can
modify, as described on page 1-23. These changes are made online and are
in effect until:

! The browser is refreshed. The trend is then reloaded with its default
parameters.

! The start time of the data display, or the tag parameters are modified, or
a tag is changed, while the grid is displayed. The grid display is then
turned off and the grid setup properties revert to default. You can
redisplay the grid by selecting Show Grid from the Options menu.

! To display the grid:

Select Show Grid from the Options menu. A grid is displayed in the Trend
Viewer, as shown in the following example:

This is a toggle option. If you do not wish to display the grid in the Trend
Viewer, select Show Grid again.
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Modifying a Grid

You can determine how the grid lines appear in the grid by specifying:

! The distance between adjacent grid lines. The grid lines then appear
with specified intervals between them, as shown in the example below:

! That the grid lines are displayed in line with the annotations on the
axis, as shown below:

You can also define the color in which the grid is displayed.
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! To modify a grid:

1. Select Grid Setup from the Setup menu. The Grid Setup dialog is
displayed:

2. In the Snap to tag field, select a tag from a list of available tags. The
selected tag is referred to when determining the line spacing.

3. In the Value Axis area, select either Each annotation to display the
grid according to the annotations on the Value axis, or enter a value in
the Spacing value field to determine the distance between the adjacent
grid lines.

The Trend mechanism will check the values you enter for their validity.
You can enter ? in the Spacing value field to view the high and low
values that are valid for the current Trend viewer settings.

4. In the Time axis area, select either Each annotation to display the grid
according to the annotations on the Time axis, or enter a value in the
Spacing value field to determine the distance between the adjacent grid
points.
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5. Click in the Grid color field to display a color pallet in which you can
select the grid color.

6. Click OK to close the dialog and save your settings. Wizcon will
display an error message if you have entered any invalid parameters.

Specifying the Orientation of the Grid Axes

In the default positioning of the grid axes, the Y axis displays tag values
and the X axis displays time, as shown below. Wizcon enables you to
change the orientation of the Value and Time axes so that the Y axis
displays time and the X axis displays tag values.

Value

Time
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In the following Trend, the orientation of the axis has been modified so that
the tag values are displayed on the X axis and the time on the Y axis.

Time

Value

Axes orientation changes are in effect until you refresh the browser.
Changes are made online and do not effect current grid setup and display
parameters.

! To change the default orientation of the grid axis:

From the Options menu, select Axis Orientation and then select Inverse
Orientation. The grid lines are adjusted so that the tag values are displayed
on the X axis and the time on the Y axis, as shown above.

Note: When Inverse Orientation is selected, the Tag Setup and Time Setup
options are disabled.
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! To revert to the default orientation settings of the grid axis:

From the Options menu, select Axis Orientation and then select Normal
Orientation. The grid lines are adjusted so that the tag values are displayed
on the Y axis and the time on the X axis, as shown on the previous page.
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Miscellaneous

This section describes additional Wizcon options available to remote users.

Alarm Objects

Wizcon enables you to associate Image objects with alarms. Such objects
are called alarm objects.

Alarm objects are influenced by their associated alarms. For example, you
can specify that an alarm object blinks when its associated alarm is active,
or provides textual assistance when selected.

Wizcon now supports alarm object attributes in a browser. They are defined
in the Alarm Object Definition dialog shown below. The available remote
options are described on the following page.
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Wizcon now supports the following alarm object attributes in a browser:

Blink

Specifies that an object will blink when the value is within the specified
value range.

Fill color

Sets the fill color of an object when the value is within one of several
specified value ranges.

Line color

Sets the line color of an object when the value is within one of several
specified value ranges.

Acknowledge

Causes the alarm associated with the object to be acknowledged whenever
the object is selected in the Trigger mode.

Acknowledge with confirm

Prompts the operator before acknowledging the alarm, as shown in the
following dialog:
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Assist

Provides textual assistance when the object is selected.

Remote users should create an HTML file with the same name as the assist
file and save it in the directory which contains the application’s HTML
files. When the alarm object is activated, the HTML file is opened together
with the assist file.

Accessing Images with Layers

Wizcon now supports the use of layers in Images that are remotely
accessed. Users can access specific layers of an Image according to group
authorization.

Note: Remember that Images accessed remotely have only scale.

Audit Trail

Audit trail is supported for remote users in much the same way as for local
users. Wizcon provides the following options for remote users:

! Audit Trail for remote users connected to an ODBC data source offers a
backup if the server fails. Wizcon creates a temp file in the temp
directory of Windows NT in text format. When connection to the server
is re-established, Wizcon reads the temp file and restores the audit trail
log.

! Audit trail logs trigger actions and login actions.

Refer to Chapter 3, System Enhancements of this guide for more details on
Audit Trail.
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Wildcard Filters for Alarm Objects

Wizcon for Internet now supports the addition of wildcards to the family
name filter used when defining alarm objects.

This option is described in more detail in Chapter 5, Alarm/Tag
Enhancements of this guide.
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Chapter 2  
Image Enhancements

About this chapter:

Modifying Object Properties, page 2-2, describes how to modify object
parameters such as tag definitions, line and color attributes, and the active
layer. It also describes the newly added Edit Properties dialog and its
features.

Line Properties, page 2-12, describes how to define lines with different
widths and types for objects that include lines as part of their shape.

Transparent Bitmaps and JPGs, page 2-14, describes how to create a
transparent bitmap in an Image.

Converting Metafiles to Wizcon Objects, page 2-16, describes how to
import metafiles into Wizcon and convert them into Wizcon objects.

Select Before Execute, page 2-17, describes the confirm option added to
trigger operation dialogs.

Browse Option for Cluster Tags, page 2-20, describes how to quickly
locate tags for cluster instance parameters.
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Modifying Object Properties

Wizcon now provides an innovative way to modify the properties of objects
in Images.

You can quickly access any object, group of objects or a cluster object and
modify the object properties.

This option is especially useful when editing cluster objects. You can select
a cluster object and edit any of its objects without ungrouping the whole
cluster.

This option enables you to:

• Modify trigger definitions and text, as described on page 2-4.

• Modify dynamic tag definitions, as described on page 2-5.

• Modify basic object attributes such as the line color, the fill color and
the active layer, as described on page 2-7.

This option does not enable you to add or remove objects from an Image, or
modify the shape of the object, for example, its size or type.

! To modify object properties:

Click on a single object to select it or click on each required object while
holding down the shift key, then right-click and select Edit Properties
from the popup menu.
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A dialog similar to the following is displayed. In this dialog, a cluster object
is selected:

The Object List on the left displays a hierarchical structure, or tree, of the
objects which comprise the cluster. The tree displays object types as folders
under which objects of that type are contained. For example, dynamic
objects are displayed in the Dynamic folder. The Object List can be
configured to display different objects types, as described on page 2-8.

Wizcon enables you to locate items according to specified strings, as
described on page 2-9, and to replace simple text or tag names, as described
on page 2-10.

Each object selected in the Object List is viewed in the Object Properties
area on the right of the dialog.
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The following options are available in the Edit Properties dialog:

Definition Enables you to modify dynamic tag parameters, as described
on page 2-5. This option is available for objects with a
definition such as a button, or an alarm. It is also available for
text. It is not available for objects that are only defined with
basic object attributes such as color or line type.

Attributes  Enables you to modify the line color, the fill color and the
active layer, as described on page 2-7.

Trigger  Displays the standard Trigger Definition dialog in which you
can modify trigger definitions. This option is available for
objects with a trigger definition. It is described in more detail
in Chapter 13, Image Animation of the Wizcon User’s Guide.
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Modifying Dynamic Tag Parameters

Wizcon enables you to access the tag parameters specified for dynamic
properties and modify them. This option does not enable you to re-define
options such as Animation, for example, change Blink to Line Color.

! To modify dynamic tag parameters:

1. Select the Definition button in the Edit Properties dialog to display the
Dynamic Object dialog. This dialog is similar in functionality to the
Dynamic Parameters dialog shown in Chapter 13, Image Animation in
the Wizcon User’s Guide, where it is described in more detail.

  



2-6  Wizcon 7.6 What’s New Guide

2. Modify the Range Parameters:

! Click the arrow to the right of the Range Parameters area and
select the required operation from the popup list. A dynamic type
that is not defined will appear in parenthesis. If you select an
undefined type, the Tag Properties, and From and To options are
disabled.

! Enter to and from values in the To and From fields to modify the
maximum and minimum tag values.

! Click Apply to save your changes.

! Click the arrow to the right of the Station field and select the
required station.

! Click the arrow to the right of the Tag field and select the required
tag.

3. Modify the Animation options:

! Click the Animation button in the Multi-Range Parameters area
to display a dialog in which you can modify the action defined in
the Multi Range Parameters field. For example, Blink.

! Click the arrow to the right of the Station field and select the
required station.

! Click the arrow to the right of the Tag field and select the required
tag.

4. Click OK to save your changes and close the dialog.



Image Enhancements  2-7

Modifying Basic Object Attributes

Wizcon provides quick access, through one dialog, to three options that are
usually defined separately during Image object definition.

Using the new Object Attributes dialog, you can modify line and fill color
and change the active layer of an object. Wizcon does not support
modifications to line types and fonts, nor enable access to transparent
colors.

! To modify basic object attributes:

1. Select the Attributes button in the Edit Properties dialog to display the
Object Attributes dialog:

 

2. Click the Line color button to display the standard Color dialog in
which you can modify the line color.

3. Click the Fill Color button to display the standard Color dialog in
which you can modify the fill color.
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4. Click the Layer Definition button to open the Select Active Layer
dialog in which you can change the layer from a list of available layers.

5. Click OK to close the dialog and save changes.

Filtering the Edit Properties Dialog

The Edit Properties dialog, in addition to providing access to the object edit
options, displays a flexible Object List that provides a number of features
that enable you to:

! Specify the object folders that appear in the Object List. Object folders
are used to display the object types that comprise the specified cluster.
For example, the Dynamic folder displays the dynamic objects. This is
described below.

! Locate items in the Object List by specifying a string and running a
match. This is useful when the Object List contains many objects and
you want to quickly locate the ones you require, as described on
page 2-9.

! Find and replace simple text or tag names in the Object List, as
described on page 2-10.

! To filter folder types:

1. From the Edit menu, choose Select. The Select Objects dialog is
displayed:
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2. Select the object type you want to display in the Object List. You can
choose from the following:

! Dynamic Object

! Alarm Object

! Trigger Objects

! Cluster Object

! Group Object

! Simple Objects

3. Click OK to close the dialog and save changes.

4. (Optional) You can display all the available folder types by choosing
Select All from the Edit menu of the Edit Properties dialog. This
overwrites your previously defined options. (It also reselects all the
options in the Select Objects dialog.)

! To locate items in the object list:

1. From the Edit menu, select Find. The Find dialog is displayed:

 

2. In the Find what field, enter the object you want to locate, for example,
circle.
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3. Enter one of the following to define the string by which the object is
located:

! Simple text

! Tag name

! Alarm family

! Trigger button

! Trigger macro

! Trigger zone

4.  Select Match case or Match whole word to define your search
criteria.

5. Wizcon searches the Object List for a match and selects the object
when found. A message is displayed if the object is not found.

6. (Optional) Select Find Next from the Edit menu or press F3 to
continue searching the tree for the next match.

! To find and replace text:

1. From the Edit menu, select Replace. The Replace dialog is displayed:

 

2. Select Simple text in the Option to Replace area.
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3. Enter the text you want to search for in the Find What field, or click
the arrow to the right of the field to select text from a list of available
text objects.

4. Enter the replacement text in the Replace With field, or click the arrow
to the right of the field to select replacement text from a list of available
text objects.

5. Click Find Next to locate the text. Click Replace to continue the find
and replace operation, or click the Replace All button for Wizcon to
automatically find and replace all matching objects. You can also click
Find Next again to simply find the next text object without replacing
the currently selected text.

6. Click Cancel to stop the find and replace and close the dialog.

! To find and replace tags:

1. From the Edit menu, select Replace. The Replace dialog is displayed.

2. Select Tag name in the Option to Replace area.

3. Enter the tag you want to search for in the Find What field, or click the
arrow to the right of the field to select a tag from a list of available tags.

4. Enter the name of the replacement tag and the station in which it is
found, in the Replace With field, or click the arrows to the right of the
fields and select replacement tags and their stations from lists of
available tags and stations.

5. Click Find Next. The tag is located. Click Replace to continue the find
and replace operation, or click the Replace All button for Wizcon to
automatically find and replace all matching tags. You can also click
Find Next again to simply find the next tag without replacing the
currently selected tag.

6. Click Cancel to stop the find and replace and close the dialog.
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Line Properties

Web-disabled

Wizcon now enables you to define lines with different widths and types for
objects that include lines as part of their shape. This option is available for
all objects, except text and pipes.

Wizcon provides the Line type button , a new tool on the far right of the
Image toolbar, to quickly access this option.

The following line widths are supported: 1, 2, 4, 6, 8 and 10 pixels.

The following line types are supported:

! Solid lines

! Dashed lines

! Dotted lines

! Alternating dashed and dotted lines

! Alternating dashed and double-dotted lines
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! To specify the line width/type:

1. Select the line you want to modify.

2. Select the Line type  button on the Image toolbar, or select
LineStyle from the Edit menu to display a dropdown menu from which
you can select the required line width/type.
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Transparent Bitmaps and JPGs

Web-disabled

Wizcon now enables you to place a JPG or BMP into an Image and define
the picture as transparent. This is especially useful for creating background
colors that should not cover other objects in the Image.

This feature enables you to include non-rectangular pictures in the Image
and gives greater flexibility when importing raster (bitmap) pictures from
other graphic programs.

Bitmaps can be pasted into an Image from the clipboard or inserted using
the Picture  icon in the Drawing toolbar.

! To define a transparent bitmap:

1. Double-click on the bitmap in the Image. The Transparency dialog is
displayed:

 

2. Select Use Transparency.
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3. Select the required color from the Color toolbox. (Note that the cursor
shape has changed.) The areas of the bitmap with the same color as the
selected color become transparent.

4. Click OK to save your changes and close the dialog.

Note: It is recommended to choose a solid color in the bitmap to define as
transparency. A color displayed in many shades of one color may not
become entirely transparent.
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Converting Metafiles to Wizcon Objects

Windows metafiles (wmf) and enhanced metafiles (emf) are vector graphic
files. Metafiles contain a series of commands which are used to display
their graphics. These commands can be translated into Wizcon Image
objects, where they become static objects (mostly polygons and ellipses).

This option is useful for importing AutoCad files or any other vector
graphic into Wizcon. You can then define trigger or dynamic operations for
the resulting Wizcon object instead of using it only as a static background.

Metafiles can be placed into Wizcon by copying and pasting them into an
Image or by importing into the Image.

! To import a metafile into an Image:

1. Select Import from the Image File menu. The standard Open dialog is
displayed.

2. Select Metafile WMF or Metafile EMF from the Files of type field
and locate the required file.

3. Select the file and click Open to import the file into the Image and
close the dialog.

! To convert a metafile:

Right-click the metafile in the Image and select Convert Metafile from the
popup menu. The metafile is converted into objects. Each object is selected.

Most of the objects in the metafile will be translated into polygons and
ellipses. They may not be grouped as in the original drawing.

Note: There are limitations that exist in programs that support metafiles.
For example, complex fillings with bitmaps will not translate well.
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Select Before Execute

Wizcon now provides added user security by displaying dialogs that must
be confirmed before an action is executed.

This option is applicable when defining a button menu for trigger objects,
as described below. The option can be enabled to display confirmation
dialogs or disabled to execute an operation without displaying a
confirmation dialog.

For information about Trigger operations, refer to Chapter 13, Image
Animation of the Wizcon User’s Guide.

The following example describes the use of dialogs that must be confirmed.

! To enable select before execute:

1. Click on an object to select it, right-click and select Trigger Definition
from the popup menu. The Trigger Object Definition dialog is
displayed.
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2. Select Buttons to display the Preset Buttons Definitions dialog.

 

3. Enter the required definitions.

4. Select Execute in the Optional area. This will display the confirmation
dialog before the action is executed.
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5. Click OK. A window containing the button panel you defined is
displayed. The example below displays the addition of an ON button to
the panel. The lower part of the window displays the following
message: Are you sure you want to activate On?

 

6. Click Execute to confirm and execute the action. You can also click
Cancel to cancel the action and return to the Preset Buttons Definition
dialog.

Note: The dialog will disappear after a predetermined amount of time if
you do not select any of the available options. The time parameter for the
display of this dialog is specified in the wiztune.dat file, as follows:

TRIGGER_BUTTONS = TIMEOUT

The default value is 20 seconds.The maximum value is 100 seconds.



2-20  Wizcon 7.6 What’s New Guide

Browse Option for Cluster Tags

After placing a cluster from a library into an Image, Wizcon enables you to
determine parameters that are used to generate the instance "personality". If
the cluster is not defined with the Define each Object when Instantiating
option, the Instance Parameters dialog is displayed, as shown below, In this
dialog, you can click the newly added Browse button to locate the tag you
want to associate with the instance parameters.

Note: If the cluster contains $ASK variables, this dialog includes the $ASK
Parameter field in which you can specify additional user data.

Instance parameters and $ASK variables are described in detail in
Chapter 12, Image Editor of the Wizcon User's Guide.

! To determine parameters:

1. Enter a unique instance name in the Instance name field.

2. Enter a tag name in the TAG NAME field or click the Browse button.
The Tags Identifier dialog is displayed:
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3. In the Station field, enter a station name, or click the arrow to the right
of the field and select the required station from a list of available
stations.
If you want to associate more than one station to the instance
parameters, select another station and click Add. The station is added
to the field.
If you want to replace the stations in the Station field, select a station
from the list of stations and click Change. The specified station is
added to the Station field, replacing all other stations.

4. In the Tag field, enter a tag name, or click the arrow to the right of the
field and select the required tag from a list of available tags.
If you want to associate more than one tag to the instance parameters,
select another tag and click Add. The tag is added to the field.
If you want to replace the tags in the Tag field, select a tag from the list
of tags and click Change. The specified tag is added to the Tag field,
replacing all other tags.
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Chapter 3  
System Enhancements

About this chapter:

System Security, page 3-2, describes how to ensure that only authorized
users access specific parts of the Wizcon system.

Audit Trail - Log Operator Actions, page 3-9, describes how to log
operator actions (tag values) to a database file. It also describes how
Wizcon recovers data in case of network failure for users connected to a
remote ODBC database source.
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System Security

Note: This option is available only for Windows NT users.

Wizcon can now provide additional system security by ensuring that users
access only those parts of the Wizcon system to which they have
authorization.

Note: The Wizcon system security must be installed to enable this option.

When the Wizcon system security is installed, it replaces the standard
Windows system control. The Wizfactory dialogs overwrite the Windows
NT dialogs. This is described in more detail on page 3-4.

Accessing the System

Each of the following options can be assigned group access.

! To assign system options to groups:

1. Select Authorization and then System from the Design menu. The
System Authorization dialog is displayed:
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2. Select a System Authorization option, as described on the following
page, and click the Groups button. By default these System
Authorization options are enabled for all groups. Deselect a group to
disable the selected System Authorization option.

3. Click OK to close the Groups dialog.

4. Select Full Security when logout to reinstate full system security when
the current logged in user logs out of the system.

5. Click OK to close the System Authorization dialog and save your
changes.

 The following options are available:

Full security (disable all)

Specifies that users will be unable to access functions such as the Task
Manager and the Start menu (with Alt-Esc), run new applications or use
a screen saver.

Disable lock station

Specifies that a user will be unable to block access to a computer by
applying a password.

Disable shutdown station

Specifies that a user will be unable to shut down a station.

Disable logoff

Specifies that a user will be unable to log out of the system.

Disable changing user password

Specifies that a user will be unable to change his or her password.

Disable ALT-ESC

Specifies that a user will be unable to access the Start menu.
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Disable ALT-TAB

Specifies that a user will be unable to navigate between the programs
open on a computer using the Alt and Tab keys.

WizFactory Dialogs

This section describes the WizFactory dialogs that replace the standard
Windows NT dialogs when the Wizcon system security is installed.

The WizFactory welcome dialog is displayed when Windows is initiated:
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The WizFactory Logon Information dialog is displayed for user logon:

The WizFactory Options Dialog is displayed when Ctrl+Alt+Delete is
pressed after logon:



3-6  Wizcon 7.6 What’s New Guide

The Logoff WizFactory station dialog is displayed when the user wants to
logoff:

The Shutdown WizFactory Station dialog is displayed when shutdown is
initiated:

Note: The above four options are accessible only to authorized users.
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The Workstation Locked dialog is displayed when the station is locked:

The Unlock Workstation dialog is displayed when a user wants to unlock
the station:
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The Change Password dialog is displayed when a user wants to change a
password:
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Audit Trail - Log Operator Actions

Wizcon now enables you to log operator actions to a database via an ODBC
data source. The operator actions are stored in a Wizcon system file in the
form of tag values. The file can be accessed and the values viewed. This
Wizcon option is called Audit Trail.

Audit Trail is a useful security feature for applications. For example, when
a user operates a trigger or logs in, you can access the database file and
view the user name of the user, where the action took place (in an Image or
through a browser) and at what time.

Wizcon logs all manual operations, but not those made using Add-on
programs, such as script language and WizPLC. In addition, Wizcon does
not record Smooth Type trigger actions.

Audit Trail for remote users connected to an ODBC data source offers a
backup if the server fails, as described on page 3-12.
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! To enable audit trail:

1. Right-click Station Properties in the All Containers list of the
Wizcon Application Studio. The Station Properties dialog is displayed.
Select the Audit Trail tab to display the following:

 

2. Select Audit Trail Enable.

! To save to a predefined database:

Enter the name of the predefined database in the Current Data
Source field or click to the right of the field and select a database
from a list of predefined sources.
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! To set up a new database:

 Click the Add Data Source button. The standard Windows Create
New Data Source wizard window is displayed, in which you can
define a database. The data source can be any valid predefined
ODBC data source.

 

 Caution: Wizcon does not support the File Data Source (Machine
independent) option.

3. A table (named AuditTrail) is added to the database. The fields in this
table are described on the following page.

4. Click Apply to select the data source as the default source, then click
OK to close the dialog.
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Data Recovery

Audit Trail provides data recovery for users connected to a remote ODBC
data source in instances of network failure.

When a network problem is discovered, Wizcon ends the session with the
remote database and creates a temp file in the temp directory of
Windows NT in text format. The file, a CSV type file, is called BCK*.tmp.

Wizcon then scans the network connection once a minute, and when
connection to the server is re-established, writes the temp file to the audit
trail file. If the information is written correctly, Wizcon then deletes the
temp file. If the information is not written correctly, Wizcon will notify you
of possible data loss.

Note: It is not recommended to work with a remote database due to
possible connection failures.
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Database Fields

The following fields and variables are added to a database file.

Field Variable and Type

UserName
Specifies which user name performed
the action.

SQL_VARCHAR 20

SourceType
Specifies the Image or browser.

SQL_VARCHAR 10

SourceName
Specifies the Image or picture name.

SQL_VARCHAR 200

SourceID
Specifies the IP address of the browser.

SQL_VARCHAR 50

Action
Specifies one of the following actions:
tag assign, zone, macro.

SQL_VARCHAR 10

TagName
Specifies the name of the tag.

SQL_VARCHAR 50

TagValue
Specifies the tag value.

SQL_DOUBLE

ZoneName
Specifies the name of the zone.

SQL_VARCHAR 20

MacroName
Specifies the name of the macro.

SQL_VARCHAR 10

TimeAction
Specifies the time and date the action
took place. When accessed through a
browser, the time and date will be that
of the server.

SQL_VARCHAR 20
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Chapter 4  
File Conversion
Enhancements

About this chapter:

Converting Communication Block Definitions, page 4-2, describes how
to export block files to CSV format and how to import them.

Converting Alarm/Tag Definitions, page 4-5, describes how to export a list
of alarms and tags to CSV format and how to import them.

Using an External Conversion Utility, page 4-9, describes how to import
tag, alarm and communication block definitions using an external
conversion utility.
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Converting Communication Block Definitions

Communication blocks are used to improve driver performance when
working with a large quantity of tags. Wizcon now provides a conversion
utility for communication block definitions. You can:

! Export communication block definitions to external sources in fixed or
CSV file format.

! Import communication block definitions to Wizcon in fixed or CSV file
format.

Communication blocks are described in detail in Chapter 6,
Communication Drivers of the Wizcon User’s Guide.

! To import/export communication block definitions:

1. In the Design menu of the Wizcon Application Studio, select
Communication Drivers. The Communication Driver dialog is
displayed.

2. Select a driver from the list of available drivers, click the Properties
button and then select the Blocks tab.
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 The communication driver properties are displayed:

 

3. Click the Files button. This displays a popup menu in which you can
select Export or Import.
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4. To export:

! Select Export from the popup menu. The Open block file for export
dialog is displayed. This is similar to the standard Open dialog.

! In the Files of type field, select one of two export options: BLS or
CSV. Then locate the file you want to import and click Open. The
file is exported.

5. To import:

! Select Import from the popup menu. The Choose block file dialog
is displayed:

 

! In the Files of type field, select the type of file you want to import.
You can choose between BLS or CSV. Then locate the file you
want to import and click Open. The imported file will replace
previous block definitions.

Note: Restart Wizcon after importing files for changes to take effect.
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Converting Alarm/Tag Definitions

Wizcon now enables you to export and import alarm and tag definitions to
CSV format.

Exporting/Importing Alarms

This section describes how to export alarms to CSV format, and how to
import them. The process of exporting and importing alarms is described in
detail in Chapter 8, Alarms of the Wizcon User’s Guide.

! To export alarms to CSV format:

1. From the Tools menu of the Wizcon Application Studio, select Export
and then Alarms. The Alarm List dialog is displayed:

 

2. Select the required filter options. Each filter field is optional except the
File field in the List Target area.
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3. Enter a file name in the File field of the List Target area.

4. Select CSV from the List Target area.

5. Click OK to generate the alarm list and close the dialog.

! To import alarms:

1. From the Tools menu of the Wizcon Application Studio, select Import
and then Alarms. The Open Alarm file for Import dialog is displayed.

2. In the Files of type field, select the type of file you want to import. You
can choose between CSV and ALS. Locate the file you want to import
and click Open. The Import Mode dialog is displayed.

3. Click Replace to replace the alarms in the alarm list with the imported
alarm, Append to add the specified alarm to the alarm list, or Cancel to
cancel the import.
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Exporting/Importing Tags

This section describes how to export tags to CSV format, and how to import
them. The process of exporting and importing tags is described in detail in
Chapter 7, Tags of the Wizcon User’s Guide.

! To export tags to CSV format:

1. From the Tools menu of the Wizcon Application Studio, select Export
and then Tags.

The Tag List dialog is displayed:

2. Select the required filter options.

3. Enter a file name in the File field.

4. Select CSV from the List Target area.

5. Click OK to generate the tag list and close the dialog.
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! To import tags:

1. From the Tools menu of the Wizcon Application Studio, select Import
and then Tags. The Open Tag file for Import dialog is displayed.

2. In the Files of type field, select the type of file you want to import. You
can choose between CSV and GLS. Locate the file you want to import
and click Open. The Import Mode dialog is displayed.

3. Click Replace to replace the alarms in the alarm list with the imported
alarm, Append to add the specified alarm to the alarm list, or Cancel to
cancel the import.
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Using External Conversion Utilities

Wizcon now provides conversion utilities for users who generate Wizcon
applications from a database. These utilities convert alarm, tag and
communication block definitions to CSV, fixed and Wizcon data files. The
converted definitions are stored in the bin directory of the Wizcon
application.

These conversion utilities run independently of Wizcon and are launched
from the command line. The following example shows how to convert a
gls file to a dat file:

Gls2dat [fromfile] [tofile]

The following utilities are available:

Name of
Utility

File In File Out Comment

als2csv alarm CSV

csv2als CSV alarm

als2dat alarm dat WizPro must not be running.

gls2csv tag CSV

csv2gls CSV tag

gls2dat tag dat WizPro must not be running.

bls2csv comm.
block

CSV

csv2bls CSV Comm
block

bls2dat comm
block

dat Wizcon can run in the
background. Restart Wizcon
for changes to take effect.
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Chapter 5  
Alarm/Tag Enhancements

About this chapter:

Expressions in Alarms, page 5-2, describes how to quickly add elaborate
expressions to alarms.

Assigning Groups to Alarms, page 5-7, describes how to assign groups to
alarms to enable user authorization.

Locating Alarms and Tags, page 5-8, describes how to locate specific
alarms and tags in the Wizcon Application Studio.

Wildcard Filters for Alarm Objects, page 5-10, describes additional
wildcard features for alarm objects.

Alarm Filters, page 5-11, describes how to define filters and tag counters
that count the number of alarms in an application.
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Expressions in Alarms

Wizcon provides a quick and easy way to enter more elaborate expressions
into alarms during alarm definition. For details about defining alarms, refer
to Chapter 8, Alarms in the Wizcon User’s Guide.

! To enter an expression:

1. Double-click the required alarm in the List of Alarms in the Wizcon
Application Studio. The Alarm Definition: dialog is displayed:
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2. In the Alarm Condition field, enter the required expression, or
right-click and select one of the options (described in the Alarm
Condition Options section below) from the popup menu.

 Expressions are displayed in the Alarm Condition field in different
colors, according to the expression type.

! Red for errors

! Black for operations

! Blue for tag names

! Olive green for functions

3. Click Apply and then OK to save your changes and close the dialog.

Alarm Condition Options

The Alarm Condition options consist of a list of tags, operators and
functions from which you can build an expression.

When Tag is selected, a field box with an arrow is added to the Alarm
Condition field. Click the arrow to the right of the field to display a
dropdown list of available tags and select the required tag.

You can only add one tag at a time to the Alarm Condition field. Clicking
anywhere in the Alarm Condition field removes the tag field box and
enters the tag into the expression. You can also enter tags manually by first
entering a @ and then the required tag name.
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Numeric Operator

Selecting Numeric Operator displays the following options:

Option Description

+ plus

- minus

= equal

/ backslash

% percentage

Relational Operators

Selecting Relational Operators displays the following options:

Option Description

= = Equal

!= Not equal

<= Less than equal

>= More than equal

< Less than

> Greater than
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Logical Operator

Selecting Logical Operator displays the following options:

Option Description

AND Combines two conditions logically.

OR Combines two conditions logically.

NOT Negates the condition that follows it.

Function

Selecting Function displays the following options:

Option Description

Log Calculates base 10 logarithm. Syntax LOG
(expression) expression>0.

Ln Calculates natural logarithm. Syntax LN(expression)
where expression > 0.

Root Calculates square root. Syntax ROOT(expression)
expression>= 0 returns the square-root of x.

Min Calculates minimum. Syntax MIN(x,y) where both x
and y are expressions returns the minimum out of the
two parameters.

Max Calculates maximum. Syntax MAX(x,y) where both
x and y are expressions returns the maximum out of
the two parameters.

Power Calculates power. Syntax POWER(x, y) where both
x and y are expressions returns the value of xy.

Sign Calculates the sign. Syntax SIGN (expression) return
–1 if expression<0 and 1 if expression >=0.
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Option Description

Floor Calculates the floor. Syntax FLOOR(expression)
return, returns a floating-point value representing the
largest integer that is less than or equal to expression.

Bit Calculates a bit. Syntax BIT(I,B) return the bit B
value from the I integer value return values are 1 if
the bit B is set and 0 if it is reset.

Abs Calculates absolute value. Syntax Abs (expression)
returns the absolute value of expression.

Sin Calculates sine. Syntax: SIN (expression) expression
angle in radians.

Cos Calculates cosine.  Syntax: COS(expression)
expression angle in radians.

Tan Calculates tangent. Syntax: TAN(expression)
expression angle in radians.

Bit Operator

Selecting Bit Operator displays the following options:

Option Description

OR Combines two conditions logically.

AND Combines two conditions logically.

XOR Exclusive OR.

NOT Negates the condition that follows.
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Assigning Groups to Alarms

Wizcon provides additional security by assigning groups to alarms. This
option enables you to specify that only users belonging to specific groups
can acknowledge or force end alarms in Events Summaries, a Browser or an
Image. If an unauthorized user tries to acknowledge or force end an alarm,
Wizcon displays an error message.

Group association is enabled during alarm definition by clicking the
Groups button in the Alarm Definition dialog shown below, and selecting
the required groups. Defining alarms is described in detail in Chapter 8,
Alarms of the Wizcon User’s Guide.
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Locating Alarms and Tags

Wizcon now enables you to locate alarms and tags in the List of Alarms and
the List of Tags in the Wizcon Application Studio. This is especially useful
if you have an application with many tags or alarms.

! To locate a tag:

1. Click anywhere in the List of Tags and select Find from the Tools
menu. The Find Tag dialog is displayed.

2. In the Find what field, enter the name of the tag you want to locate, its
description or its address.

3. In the Conditions area, select either Tag name, Description or
Address depending on the tag criteria you entered in the Find what
field.

4. Click Find. The tag is located in the List of Tags.

5. Click Exit or anywhere in the Wizcon Application Studio outside the
List of Tags to close the dialog.
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! To locate an alarm:

1. Click anywhere in the List of Alarms and select Find from the Tools
menu. The Find Alarm dialog is displayed:

 

2. Enter the alarm text in the Alarm Text field.

3. Enter the alarm family in the Family field.

4. Select the condition(s) by which you want to conduct the search in the
Conditions area. You can choose between Alarm Text, Family name
or Both.

5. Click Find. The alarm is located in the List of Alarms.

6. Click Exit or anywhere in the Wizcon Application Studio outside the
List of Alarms to close the dialog.
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Wildcard Filters for Alarm Objects

This section describes the addition of wildcards that are applied to the
family filter used when defining alarm objects.

Wizcon provides a  ? and * wildcard to enable you to quickly define family
filters. For example, the definition XYZ?123 will update an alarm object
for the alarms with a family name that:

! Starts with XYZ.

! Has any letter as its 4th character.

! Ends with 123.

Defining alarm objects is described in the Alarm Object section of
Chapter 13, Image Animation of the Wizcon User’s Guide.
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Alarm Filters

Wizcon now enables a user to define filters and apply tag counters to
alarms. The tag counters collect the specified alarm information which can
be used in Images or SQL.

The alarm filter is automatically activated when Wizcon is loaded.

Alarm filters are specified in the Alarm Filters dialog, as follows:

! To specify an alarm filter:

1. Select Alarm Filter from the Design menu of the Wizcon Application
Studio. The Alarm Filters dialog is displayed:
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2. Click Add. The Alarm Filter Definition dialog is displayed:

 

3. Enter a name for the alarm filter in the Name of Alarm Filter field.

4. Specify filter settings and Class options in the Filter Settings area.

5. Specify stations in the filter by selecting a station from the list of
stations in the Network Station List and clicking the Add Station
button. The station is added to the Stations for Filter list.
Alternatively, you can remove a station from a filter by selecting the
station in the Stations for Filter list and clicking the Remote Station
button.
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6. Specify alarm counters by clicking the field of an option in the
Counters Tag Assignments area and selecting a tag from the
dropdown list. The following options are available:

Alarms Started and UnAcked Specifies activated alarms.

Alarms Started and Acked Specifies acknowledged alarms.

Alarms Ended and UnAcked Specifies alarms that were activated
and not acknowledged.

7. Click OK to save your settings and close the dialog.
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